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Pivot Tables

• Many Excel experts believe that pivot tables are 
the single most powerful tool in Excel. According 
to Bill Jelen (a.k.a. Mr. Excel) "No other tool in 
Excel gives you the flexibility and analytical Excel gives you the flexibility and analytical 
power of a pivot table". I agree completely. 
Excel Pivot Tables are fun and powerful. So, in 
no particular order, here are some things you 
should know about them.



23 Key Things to Know About Pivot Tables
1. You can build a pivot table in about one 

minute
• Many people have the idea that building a pivot table is 

complicated and time-consuming, but it's simply not 
true. Compared to the time it would take you to build 
an equivalent report manually, pivot tables are 
incredibly fast. If you have well-organized source data, 
you can create a pivot table less than a minute. Here's 
how:
you can create a pivot table less than a minute. Here's 
how:

a)Select any cell in the source data
b) On the Insert tab of the ribbon, click the PivotTable 

button
c) In the Create PivotTable dialog box, check the data 

and click OK
d) Drag a "label" field into the Row Labels area (e.g. 

customer)
e) Drag a numeric field into the Values area (e.g. sales)



2. Perfect your source data
• To minimize problems down the road, always 

use good quality source data, organized in a 
tabular layout. "Perfect" source data will have no 
blank rows or columns, and no subtotals. Each 
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blank rows or columns, and no subtotals. Each 
column will have a unique name (on one row 
only), every field will have a value in every row, 
and columns will not hold repeated groups of 
data (i.e. month names, location names, region 
names, etc.)



3. Count the data first
• When you first create a pivot table, use it to generate 

a simple count first to make sure the pivot table is 
processing the data as you expect. To do this, simply 
add any text field as a Value field. You'll see a very 
small pivot table that displays the total record count, 
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small pivot table that displays the total record count, 
that is, the total number of rows in your data. If this 
number makes sense to you, you're good to go. If the 
number doesn't make sense to you, it's possible the 
pivot table is not reading the data correctly or that 
the data has not been defined correctly.



4. Plan before you build
• Although it's a lot of fun dragging fields around a 

pivot table, and watching Excel churn out yet another 
unusual representation of the data, you can find 
yourself going down a lot of unproductive rabbit holes 
very easily. An hour later, it's not so fun anymore. 
Before you start building, jot down what you are 
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Before you start building, jot down what you are 
trying to measure or understand, and sketch out a few 
simple reports on a notepad. These simple notes will 
help guide you through the huge number of choices 
you have at your disposal. Keep things simple, and 
focus on the questions you need to answer.



5. Use a table for your data to create a "dynamic range“

• If you use an Excel Table for the source data of your pivot 
table, you get a very nice benefit: your data range becomes 
"dynamic". A dynamic range will automatically expand and 
shrink the table as you add or remove data, so won't have to 
worry that the pivot table is missing the latest data. When you 
use a Table for your pivot table, the pivot table will always be 
in sync with your data.

23 Key Things to Know About Pivot Tables

in sync with your data.
• To use a Table for your pivot table:
a) Select any cell in the data use the keyboard shortcut Ctrl-T to 

create a Table
b)Click the Summarize with PivotTable button (TableTools > 

Design)
c)Build your pivot table normally
d)Benefit: data you add to your Table will automatically appear 

in your Pivot table on refresh



6. Use a pivot table to count things
By default, a Pivot Table will count any text field. 

This can be a really handy feature in a lot of 
general business situations. For example, 
suppose you have a list of employees and want to 
get a count by department? To get a breakdown 
by department, follow these steps:

23 Key Things to Know About Pivot Tables

by department, follow these steps:
a)Create a pivot table normally
b) Add the Department as a Row Label
c) Add the employee Name field as a Value
d) The pivot table will display a count of employee 

by Department



7. Show totals as a percentage
• In many pivot tables, you'll want to show a percentage 

rather than a count. For example, perhaps you want to 
show a breakdown of sales by product. But, rather than 
show the total sales for each product, you want to show 
sales as a percentage of the total sales. Assuming you 
have a field called Sales in your data, just follow these 
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have a field called Sales in your data, just follow these 
steps:

a) Add Product to the pivot table as a Row Label
b) Add Sales to the pivot table as a Value
c) Right-click the Sales field, and set "Show Values As" to 

"% of Grand Total“



8. Use a pivot table to build a list of unique 
values

• Because pivot tables summarize data, they can be 
used to find unique values in a field. This is a good 
way to quickly see all the values that appear in a field 
and also find typos, and other inconsistencies. For 
example, suppose you have sales data and you want 
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example, suppose you have sales data and you want 
to see a list of every product that was sold. To create a 
product list:

a) Create a pivot table normally
b) Add the Product as a Row Label
c) Add any other text field (category, customer, etc) as 

a Value
d) The pivot table will show a list of all products that 

appear in the sales data



9. Create a self-contained pivot table
• When you've created a pivot table from data in 

the same worksheet, you can remove the data if 
you like and the pivot table will continue to 
operate normally. This is because a pivot table 
has a pivot cache that contains an exact 
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has a pivot cache that contains an exact 
duplicate of the data used to create the pivot 
table.

• Refresh the pivot table to ensure cache is up to 
date (PivotTable Tools > Refresh)

• Delete the worksheet that contains the data
• Use your pivot table normally



10. Group a pivot table manually
• Although pivot tables automatically group data in many ways, 

you can also group items manually into your own custom 
groups. For example, assume you have a pivot table that 
shows a breakdown of employees by department. Suppose you 
want to further group the Engineering, Fulfillment, and 
Support departments into Group 1, and Sales and Marketing 
into Group 2. Group 1 and Group 2 don't appear in the data, 
they are your own custom groups. To group the pivot table 
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they are your own custom groups. To group the pivot table 
into the ad hoc groups, Group 1 and Group 2:

a) Control-click to select each item in the first group
b) Right-click one of the items and choose Group from the menu
c) Excel creates a new group, "Group1"
d) Select Marketing and Sales in column B, and group as above
d) Excel creates another group, "Group2"



11. Group numeric data into ranges
• One of the most interesting and powerful 

features that every pivot table has is the ability to 
group numeric data into ranges or buckets. For 
example, assume you have a list of voting results 
that includes voter age, and you want to 

23 Key Things to Know About Pivot Tables

that includes voter age, and you want to 
summarize the results by age group:



12. Rename fields for better readability
• When you add fields to a pivot table, the pivot 

table will display the name that appears in the 
source data. Value field names will appear with 
"Sum of " or "Count of" when they are added to a 
pivot table. For example, you'll see Sum of Sales, 
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pivot table. For example, you'll see Sum of Sales, 
Count of Region, and so on. However, you can 
simply overwrite this name with your own. Just 
select the cell that contains the field you want to 
rename and type a new name.



13. Add a space to field names when Excel 
complains

• When you try to rename fields, you might run into a 
problem if you try to use exactly the same field name 
that appears in the data. For example, suppose you 
have a field called Sales in your source data. As a 
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have a field called Sales in your source data. As a 
value field, it appears as Sum of Sales, but (sensibly) 
you want it to say Sales. However, when you try to 
use Sales, Excel complains that the field already 
exists, and throws a "PivotTable field name already 
exists" error message.

• As a simple work around, just add a space to the end 
of your new field name. You can't see a difference, 
and Excel won't complain.



14. Add a field more than once to a pivot table
• There are many situations when it makes sense to add the 

same field to a pivot table more than once. It may seem odd, 
but you can indeed add the same field to a pivot table more 
than once. For example suppose you have a pivot table that 
shows a count of employees by department.

• The count works fine, but you also want to show the count as a 
percentage of total employees. In this case, the simplest 
solution is to add the same field twice as a Value field:
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solution is to add the same field twice as a Value field:
a) Add a text field to the Value area (e.g. First name, Name, etc.)
b) By default, you'll get a count for text fields
c) Add the same field again to the Value area
d) Right-click the second instance, and change Show Values As 

to "% of Grand Total"
e) Rename both fields as you wish



• 15. Automatically format all value fields
• Any time you add a numeric field as a Value in a pivot table, 

you should set the number format directly on the field. You 
may be tempted to format the values you see in the pivot table 
directly, but this is not a good idea, because it's not reliable as 
the pivot table changes. Setting the format directly on the field 
will ensure that the field is displayed using the format you 
want, no matter how big or small the pivot table becomes.

• For example, assume a pivot table that shows a breakdown of 
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• For example, assume a pivot table that shows a breakdown of 
sales by Region. When you first add the Sales field to the pivot 
table, it will be displayed in General number format, since it's 
a numeric field. To apply the Accounting number format to 
the field itself:

a)Right-click on the Sales field and select Value Field Settings 
from the menu

b) Click the Number Format button in the Value field settings 
dialog that appears

c) Set the format to Accounting and click OK to exit



16. Drill down to see (or extract) the data 
behind any total

• Whenever you see a total displayed in a pivot table, 
you can easily see and extract the data that makes 
up the total by "drilling down". For example, assume 
you are looking at a pivot table that shows employee 
count by department. You can see that there are 50 
employees in the Engineering department, but you 
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employees in the Engineering department, but you 
want to see the actual names. To see the 50 people 
that make up this number, double-click directly on 
the number 50 and Excel will add a new sheet to 
your workbook that contains the exact data used to 
calculate 50 engineers. You can use this same 
approach to see and extract data behind totals 
wherever you see them in a pivot table.



• 17. Clone your pivot tables when you need another view
• Once you have one pivot table set up, you might want to see a 

different view of the same data. You could of course just rearrange 
your existing pivot table to create the new view. But if you're 
building a report that you plan to use and update on an on-going 
basis, the easiest thing to do is clone an existing pivot table, so that 
both views of the data are always available.

• There are two easy ways to clone a pivot table. The first way 
involved duplicating the worksheet that holds the pivot table. If you 
have a pivot table set up in worksheet with a title, etc., you can just 
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have a pivot table set up in worksheet with a title, etc., you can just 
right click the worksheet tab to copy the worksheet into the same 
workbook. Another way to clone a pivot table is to copy the pivot 
table, and paste it somewhere else. Using these approaches, you can 
make as many copies as you like.

• When you clone a pivot table this way, both pivot tables share the 
same pivot cache. This means that when you refresh any one of the 
clones (or the original) all of the related pivot tables will be 
refreshed.



18. Unclone a pivot table to refresh independently
• After you've cloned a pivot table, you might run into a situation 

where you really don't want the clone to be linked to the same pivot 
cache as the original. A common example is after you've grouped a 
date field in one pivot table, refresh, and discover that you've also 
accidentally grouped the same date field in another pivot table that 
you didn't intend to change. When pivot tables share the same pivot 
cache, they also share field grouping as well.

• Here's one way to unclone a pivot table, that is, unlink it from the 
pivot cache it shares with other pivot tables in the same worksheet:
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pivot cache it shares with other pivot tables in the same worksheet:
• Cut the entire pivot table to the clipboard
• Paste the pivot table into a brand new workbook
• Refresh the pivot table
• Copy it again to the clipboard
• Paste it back into the original workbook
• Discard the temporary workbook
• Your pivot table will now use it's own pivot cache and will not 

refresh with the other pivot table(s) in the workbook, or share the 
same field grouping.



19. Get rid of useless headings
• The default layout for new pivot tables is the 

Compact layout. This layout will display "Row 
Labels" and "Column Labels" as headings in the 
pivot table. These aren't the most intuitive headings, 
especially for people that don't often use pivot 
tables. An easy way to get rid of these odd headings 
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tables. An easy way to get rid of these odd headings 
is to switch the pivot table layout from Compact to 
Outline or Tabular layout. This will cause the pivot 
table to display the actual field names as headings in 
the pivot table, which is much more sensible. To get 
rid of these labels altogether, look for a button called 
Field Headers on the Analyze tab of the Pivot Table 
Tools ribbon. Clicking this button will disable 
headings completely.



• 20. Add a little white space around your 
pivot tables

• This is just a simple design tip. All good designers 
know that a pleasing design requires a little white 
space. White space just means empty space set aside 
to give the layout breathing room. After you create a 
pivot table, insert an extra column to the left and an 
extra row or two at the top. This will give your pivot 
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extra row or two at the top. This will give your pivot 
table some breathing room and create a better 
looking layout. In most cases, I also recommend that 
you turn off gridlines on the worksheet. The pivot 
table itself will present a strong visual grid, so the 
gridlines outside the pivot table are unnecessary, 
and will simply create visual noise.



• 21. Get rid of row and column grand 
totals

• By default, pivot tables show totals for both rows 
and columns, but you can easily disable one or 
both of these totals if you don't want them. On 
the Pivot Table tab of the ribbon, just click the 
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the Pivot Table tab of the ribbon, just click the 
Totals button and choose the options you want.



22. Format empty cells
• If you have a pivot table that has a lot of blank cells, you 

can control the character that is displayed in each blank 
cell. By default, empty cells will display nothing at all. To 
set your own character, right-click inside the pivot table 
and select Pivot Table options. Then make sure that 
"Empty cells as:" is checked, and enter the character you 
want to see. Keep in mind that this setting respects the 
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want to see. Keep in mind that this setting respects the 
applied number format. For example. if you are using the 
accounting number format for a numeric value field, and 
enter a zero, you'll see a hyphen "-" displayed in the pivot 
table, since that's how zero values are displayed with the 
Accounting format.



23. Turn off AutoFit when necessary
• By default, when you refresh a pivot table, the 

columns that contain data are adjusted 
automatically to best fit the data. Normally, this is a 
good thing, but it can drive you crazy if you have 
other things on worksheet along with the pivot table, 
or if you have carefully adjusted the column widths 
manually and don't want them changed. To disable 
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manually and don't want them changed. To disable 
this feature, right-click inside the pivot table and 
choose PivotTable Options. In the first tab of the 
options (or the layout tab on a Mac), uncheck 
"AutoFit Column Widths on Update".



Vlookup functions
There are four pieces of information that you will need in order to build 

the VLOOKUP syntax:
• The value you want to look up, also called the lookup value.

• The range where the lookup value is located. Remember that the 
lookup value should always be in the first column in the range for 
VLOOKUP to work correctly. For example, if your lookup value is in 
cell C2 then your range should start with C.cell C2 then your range should start with C.

• The column number in the range that contains the return value. For 
example, if you specify B2: D11 as the range, you should count B as 
the first column, C as the second, and so on.

• Optionally, you can specify TRUE if you want an approximate match 
or FALSE if you want an exact match of the return value. If you don't 
specify anything, the default value will always be TRUE or 
approximate match.



Vlookup function

=VLOOKUP(Value you want to look up, range where 
you want to lookup the value, the column number in 
the range containing the return value, Exact Match or 
Approximate Match – indicated as 0/FALSE or Approximate Match – indicated as 0/FALSE or 
1/TRUE).



Vlookup Function
• The following picture shows how you'd set up your VLOOKUP 

to return the price of Brake rotors, which is85.73. 



Vlookup Function

• D13 is lookup_value, or the value you want to look up.
• B2 to E11 (highlighted in yellow in the table) is 

table_array, or the range where the lookup value is 
located. 

• 3 is col_index_num, or the column number in 
table_array that contains the return value. In this 
example, the third column in the table array is Part example, the third column in the table array is Part 
Price, so the formula output will be a value from the 
Part Price column.

• FALSE is range_lookup, so the return value will be an 
exact match.

• Output of the VLOOKUP formula is 85.73, the price of 
Brake rotors.



ThankThank


